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Getting Started with Telnet 
From the Telnet application window, two main Telnet functions can be accessed: 

• Establishing Telnet Sessions - Establishing and managing Telnet sessions 
involves logging in to one or more devices and configuring the devices via 
supported CLI commands. Note that OmniVista Telnet also supports SSHv2 
enhanced Telnet encryption.  

• Telnet Scripting - Creating Telnet Scripting files involves manually creating a 
text-based script file within OmniVista and then configuring one or more 
devices by applying the file via Telnet. Users can also import existing text-based 
script files and create a template script. 

Establishing a Telnet Session 

To establish a basic Telnet session with a device, begin by clicking open the Switches directory in the 
Navigation Tree. One or more Subnet directories displays in the Tree. Click open the applicable Subnet 
directory, then single-click on the icon or IP address of the desired device. A Telnet session for the device 
launches automatically. 

To establish a basic Telnet session in a new window, right-click a device's icon or IP address in the Tree 
and select New Window -> Telnet. A new instance of OmniVista is opened and a Telnet session to the 
corresponding device is launched. 
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Note: If SSH has been configured as the preferred encryption type, the term SSH will be used in the 
place of Telnet in OmniVista's pop-up menus, application buttons, etc. 

If Automatic Login has not been configured for the device, enter the login ID and password for the device 
in the Telnet window. If Automatic Login has been configured, OmniVista will enter the login ID and 
password automatically. 

After login is complete, the CLI command prompt displays. A successful Telnet session has been 
established and the device is now ready to be managed and/or configured via the CLI. 

Launching Telnet Sessions Using the Pull-Down Navigation Menu 

Telnet sessions can also be launched from the pull-down menu located at the top of the main Telnet 
window. However, be sure that a particular subnet has first been selected in the Navigation Tree. When a 
subnet is selected, the pulldown menu lists all discovered devices in that subnet. Simply scroll and click to 
select a device from the menu; a Telnet session for the device launches automatically. 
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Note: Unlike the Navigation Tree, the pull-down navigation menu does not show 
additional status information, such as a device's type or whether it is reachable. 

Managing Multiple Telnet Sessions 

Multiple sessions can be launched and managed within the same instance of the Telnet application. To 
establish multiple Telnet sessions, simply select multiple devices, one at a time, from the Navigation Tree. 
A new tab displays for each session, with each tab indicating the IP address for its corresponding session. 
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To access a particular Telnet session, click on the tab showing the device's IP address. The corresponding 
Telnet window displays. 

Note: Multiple Telnet sessions can also be launched from the pull-down menu located at 
the top of the OmniVista window. Scroll and click to select devices from the pull-down 
menu; a Telnet session for each device launches automatically and a new tab for each 
session displays. 

Closing Telnet Sessions 

To close a Telnet session, click the Disconnect button at the bottom of the Telnet window or type exit at 
the command prompt. 

If multiple sessions are being managed, clicking the Close Tab button disconnects a session and also closes 
its corresponding tab. (Note that the Close Tab button is not available if only one Telnet session is open.) 

Reestablishing Closed Sessions 

When a session has been disconnected, it can be quickly reconnected by clicking the Telnet button at the 
bottom of the Telnet window. If multiple sessions are being managed, be sure that the tab for the desired 
device is selected before clicking the Telnet button. Otherwise, sessions can be reestablished by following 
the steps described in the "Establishing a Telnet Session" and "Managing Multiple Telnet Sessions" 
sections. 
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Returning to the Main Telnet Window 

To return to the main Telnet window (i.e., the window displayed when the Telnet application was first 
launched), single-click the Switches directory in the Navigation Tree. The main Telnet window, showing 
the Create Scripts, Send Script, and View Logs tabs displays. 

Using Telnet Scripting 

A Telnet script file is a text-based file used to configure one or more devices through OmniVista's Telnet 
Scripting feature. Telnet scripting is especially useful in applying batch updates or common configurations 
across multiple devices. A script file must contain only CLI commands supported on AOS switches. When 
a script file is applied, each CLI command in the file is sent to the device via Telnet. 

Important Note: Before attempting to apply a script, OmniVista must know the user 
name and password for each device being configured. Use Auto-Login to specify the 
login information. 

Users are not required to create script files using a third-party text editor. OmniVista provides a text box 
where CLI commands can be manually entered from the Telnet application. During the Telnet Scripting 
steps, these commands are saved to a script file (which can be accessed for reference or future 
applications). 

Creating Script Files 

To create a script, click the New button. Enter a descriptive file name in the Enter Filename text field. For 
example, new_vlan_config1. (The file extension .script will be added automatically when the script file is 
saved.) 

Next, press the Tab key or select the Enter Scripts text box. Enter the CLI commands to be applied to the 
switch via this script. Be sure that all commands entered are AOS-compatible CLI commands; also, enter 
only one CLI command per line. 

Important Note: Operational commands that automatically issue a confirmation prompt 
and require the user to type a response (like Y or N) are not supported in CLI script files. 
Examples include takeover, reload, fsck, etc. Do not attempt to include these command 
types in the script file. Instead, manually issue them via the standard CLI command line 
prompt. These operations can also be issued on a device-by-device basis via WebView or 
OmniVista. 

Verify that the syntax of all commands is correct before proceeding. When finished, click the Save button. 
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Template Scripts 

When the script is sent, the CLI commands in the script file are displayed in the Scripts Content window. 
If the script is a "template" script, a pop-up is displayed to allow the user to specify values for variables.  

 

A "template" script is a script that contains special non-CLI syntax and keywords that represent OmniVista 
built-in variables or user defined variables. The variables in the template must be prefixed with '$' to show 
they are variables. The built-in variables are:  

• $IP_ADDRESS - replaced automatically with target switch IP address.  
• $BOOT_DIR - replaced automatically with target boot directory (ex: working).  
• $BASE_MAC - replaced automatically with target base MAC address.  
• $CHASSIS_TYPE - replaced automatically with target chassis type.  
• $SYSTEM_OID - replaced automatically with target unique object ID.  
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• $LOGIN_ID - replaced automatically with target FTP/Telnet login ID.  
• $LOGIN_PWD - replaced automatically with target FTP/Telnet login password.  
• $READ_PWD - replaced automatically with target community string for SNMP reading.  
• $WRITE_PWD - replaced automatically with target community string for SNMP writing.  

You must specify the variable names exactly as they are in the template script - upper and lower case must 
match. For example, if a variable in the script is "$MixedCaseVAR", then the user must specify it the same 
way when adding this parameter to a 'Send Session'. 

To create variables in a "template" script:  

1. Click on the variable name. The fields for entering the value will be enabled.  

2. Enter the value for the variable in Variable Value field.  

3. Click Set Value. The value will be displayed in the Variable Value column.  

4. Click Send. 

Importing Existing Script Files 

Although OmniVista allows users to manually create script files within the Telnet application, existing 
script files can also be imported. In other words, a file containing a set of CLI commands can be accessed 
from a server or local drive and then applied to one or more devices. This allows users to maintain a library 
of network configurations and then apply them to devices in their network as needed. 

Before importing a file to one or more devices, consider the following important guidelines: 

• Any script file being imported must be text-based (ASCII).  
• Although file extensions such as .txt and .ascii are supported, the file extension .script is 

recommended.  
• All CLI commands contained in the file must be AOS-supported. Also, operational commands that 

automatically issue a confirmation prompt and require the user to type a response (like Y or N) are 
not supported in CLI script files. Examples include takeover, reload, fsck, etc.  

• CLI commands must also be entered into the text file one command per line.  
• Only one script file can be imported at a time.  

To import a script file, click the Import button at the bottom of the main Telnet window. The Import 
Scripting File dialog box displays. Use the dialog box's Look In pull-down menu to locate the file being 
imported. 

Note: If you are browsing for a file with an extension other than .script, be sure to select 
Files of Type -> All Files in the dialog box, as shown: 
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Once the script file has been located, select the file in the dialog box window; the file name displays in the 
File Name text field. Click the Import button. 

 

Important Note: The script import procedure is not complete at this point. You must 
click on the Send Script tab in the main Telnet window and follow the remaining steps in 
order to send the script file to the device(s). 
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Editing Script Files 

To edit a script file, select the file from the Filename list, then click Edit. The Enter Scripts text box 
(which was previously grayed out) becomes active. The CLI commands contained in the selected script file 
can now be deleted, modified, or appended. When the changes are complete, click the Save button. 

Important Note: When the changes are saved, the previous contents of the script file are 
overwritten. To preserve the original contents of the file, be sure to make a backup copy 
before editing. 

Deleting Script Files 

To delete a script file, select the file from the Filename list, then click Delete. 

Note: When a file is deleted, it is permanently removed from the scripting_files 
directory. Once a script file is deleted, it cannot be recovered. 

Click Yes in the Warning dialog box. 

 

Deleting Multiple Script Files 

Multiple log files can be deleted at once. To delete multiple script files, simply Control-click or Shift-click 
all applicable files in the list before clicking Delete. Remember, however, that once the files have been 
deleted, they cannot be recovered.  
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Using the OmniVista Telnet Application 
OmniVista's Telnet application provides a feature set well beyond that of standard Telnet session support. 
Features include: 

• Telnet support  
• Automatic login for one or more devices  
• Multiple Telnet session management  
• Telnet Script file support for one or more AOS devices 
• Secure Shell (SSHv2) support.  

Opening the Telnet Application 

There are two different ways to open the Telnet application. Telnet can either be accessed from 
OmniVista's Task Bar, or from within another open OmniVista application, such as Topology, VLANs, etc. 

When the Task Bar is used, the main Telnet window is displayed. Sessions are not automatically launched; 
instead, the user can choose a particular Telnet feature (e.g., Telnet Scripting) and launch sessions to one or 
more devices as needed. 

When Telnet is accessed from another open OmniVista application, a Telnet session with the selected 
device launches automatically. 

Opening Telnet from the Task Bar 

To open the Telnet application from the Task Bar, click the Configuration group button. Click the Telnet 
button (scrolling may be required to access the Telnet button). The Telnet application loads. 

10 



Using the OmniVista Telnet Application 

 

The main Telnet window allows users to access the two main Telnet functions: 

• Establishing and Managing Telnet Sessions  
• Creating or Importing Telnet Scripting Files  

For more information on these functions, refer to the Getting Started with Telnet section. 

Opening Telnet from Other Applications 

Telnet sessions can also be launched from other OmniVista applications by right-clicking devices in the 
Navigation tree. For example, from the VLANs application, right-click on a device listed in the tree and 
select Current Window -> Telnet or New Window -> Telnet from the popup menu. Telnet will be 
opened directly from VLANs and a session to the selected device will launch. 

Note that launching a Telnet session in a new window allows users to preserve the current view in an open 
OmniVista application. So, for example, if a user is viewing detailed configuration information using the 
VLANs application and a Telnet session is needed for a quick configuration change, launching the session 
in a new window may be preferred. 
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Navigating Telnet 

The screen below shows key navigation components of the Telnet application. The left side of the main 
Telnet window lists all discovered devices. To establish a telnet session, expand the tree and select a 
device. The tabs on the right side of the screen are used to configure, apply, and view telnet scripts. 

• Create Scripts - A Telnet script file is a text-based file used to configure one or more devices 
through OmniVista's Telnet scripting feature. You can create new telnet scripts or import existing 
scripts. 

• Send Scripts - Once you have created a script, you must send that script to a device or devices. 
• View Logs - Log files are created when you send a script to a device or devices. You can view the 

log file by clicking on the View Logs tab and selecting the file. 

 

Establishing a Basic Telnet Session 

To establish a basic Telnet session with a device, begin by clicking the Switches directory in the 
Navigation tree. One or more Subnet directories are displayed in the tree. Click the applicable Subnet 
directory, and then single-click the icon or IP address of the desired device. A Telnet session for the device 
launches automatically. 

To establish a basic Telnet session in a new window, right-click a device's icon or IP address in the tree and 
select New Window -> Telnet. A new instance of OmniVista is opened and a Telnet session to the 
corresponding device is launched. 
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Note: If SSH has been configured as the preferred encryption type, the term SSH will be used in the 
place of Telnet in OmniVista's pop-up menus, application buttons, etc. For detailed information on 
setting SSH as the preferred encryption type for one or more devices, click here. 

If Automatic Login has not been configured for the device, enter the login ID and password for the device 
in the Telnet window. If Automatic Login has been configured, OmniVista will enter the login ID and 
password automatically. 

After login is complete, the CLI command prompt is displayed. A successful Telnet session has been 
established and the device is now ready to be managed and/or configured via the CLI. 

Launching Telnet Sessions Using the Pull-Down Navigation Menu 

Telnet sessions can also be launched from the pull-down menu located at the top of the main Telnet 
window. However, be sure that a particular subnet has first been selected in the Navigation tree. When a 
subnet is selected, the pull-down menu lists all discovered devices in that subnet. Simply scroll and click to 
select a device from the menu; a Telnet session for the device launches automatically. 
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Note: Unlike the Navigation tree, the pull-down navigation menu does not show 
additional status information, such as a device's type or whether it is reachable. 

Managing Multiple Telnet Sessions 

Multiple sessions can be launched and managed within the same instance of the Telnet application. To 
establish multiple Telnet sessions, simply select multiple devices, one at a time, from the Navigation tree. 
A new tab is displayed for each session, with each tab indicating the IP address for its corresponding 
session. 
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To access a particular Telnet session, click the tab showing the device's IP address. The corresponding 
Telnet window is displayed. 

Note: Multiple Telnet sessions can be launched from the pulldown menu located at the 
top of the OmniVista window also. Scroll and click to select devices from the pulldown 
menu; a Telnet session for each device launches automatically and a new tab for each 
session is displayed. 

Closing Telnet Sessions 

To close a Telnet session, click the Disconnect button at the bottom of the Telnet window or type exit at 
the command prompt. 

If multiple sessions are being managed, clicking the Close Tab button disconnects a session and also closes 
its corresponding tab. (Note that the Close Tab button is not available if only one Telnet session is open.) 

Reestablishing Closed Sessions 

When a session has been disconnected, it can be quickly reconnected by clicking the Telnet button at the 
bottom of the Telnet window. If multiple sessions are being managed, be sure that the tab for the desired 
device is selected before clicking the Telnet button. Otherwise, sessions can be reestablished by following 
the steps described in the "Establishing a Basic Telnet Session" and "Managing Multiple Telnet Sessions" 
sections. 
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Configuring Automatic Login 

Automatic Login (also referred to as Auto-Login) allows users to pre-configure the user ID and password 
for one or more devices. This allows OmniVista to automatically log into a device whenever a Telnet 
session is launched. In other words, the user is not required to type the user ID or password when the Telnet 
session reaches the login prompt. Instead, the information is entered automatically and the cursor is moved 
directly to the command prompt. 

Important Note: Auto-Login is required whenever applying scripts and importing scripts 
to a device. If Auto-login is not pre-configured for the device, a login error will result. 

The Auto-Login feature can be configured on a device-by-device basis, or for multiple devices at once. 
Note that when Auto-Login is configured, the changes are only applied to OmniVista's Telnet login 
preferences. Login settings on the device itself are not affected. 

Configuring Automatic Login for a Single Device 

To configure Auto-Login for a single device, right-click the device in the Telnet navigation tree and select 
Edit from the popup menu that displays. 

 

The Edit-Discovery-Manager-entry dialog box is displayed. Enter the user ID and password for the 
device in the Telnet/FTP User Name and Telnet/FTP Password text fields. If SSH (Secure Shell) is the 
preferred Telnet encryption type, click the Prefer SSH checkbox. (When this box is checked, future Telnet 
sessions for this device will use SSH.) Click the Allow Port Disabling checkbox to enable port disabling 
for a device. By default, all devices prohibit port disabling. When finished, click the OK button. 
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Note: For information on verifying Auto-Login for one or more devices, refer to the 
Verifying Automatic Login section. 

Configuring Automatic Login for Multiple Devices 

Auto-Login for multiple devices is configured through OmniVista's Topology application. Topology allows 
users to select multiple devices from a list and, in one step, specify the user ID and password to be used for 
future Telnet sessions. SSH (Secure Shell) can also be set as the default Telnet encryption for all selected 
devices. 

To set up Auto-Login for multiple devices, start by opening the Topology application. (Topology can be 
accessed via the Task Bar by clicking the Configuration group button and then the Topology application 
button.) 

When Topology launches, a list of all discovered devices is displayed. Using Control-click or Shift-click, 
select the devices from the list. Right-click any of the selected devices. A popup menu is displayed. Select 
Edit from the menu. 

17 



Using the OmniVista Telnet Application 

 

The Edit Discovery Manager Entry dialog box is displayed. Enter the user ID and password for the 
selected devices in the Telnet/FTP User Name and Telnet/FTP Password text fields. If SSH (Secure 
Shell) is the preferred Telnet encryption type, click the Prefer SSH checkbox . (By default, future Telnet 
sessions for the selected devices will use SSH.) Click the Allow Port Disabling checkbox to enable port 
disabling for the selected devices. By default, all devices prohibit port disabling. When finished, click the 
OK button. 
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Note: For information on verifying Auto-Login for one or more devices, refer to the 
Verifying Automatic Login section. 

Verifying Automatic Login 

Verify the Auto-Login setup by launching a Telnet session to a device where Auto-Login information has 
been specified. When the session is launched, the user ID and password fields should be populated 
automatically and the cursor should move directly to the command prompt. 
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Note: If an Auto-Login error occurs (i.e., the Telnet connection times out), be sure that 
the user ID and password for the device are correct and that the device is reachable. To 
check whether a device is reachable, right-click the device in the Navigation Tree and 
select Ping Node from the popup menu. The results of the ping are displayed in the 
Status pane at the bottom of the main OmniVista window. 

Creating Script Files 

A Telnet script file is a text-based file used to configure one or more devices through OmniVista's Telnet 
scripting feature. Telnet scripting is especially useful in applying batch updates or common configurations 
across multiple devices. A script file must contain only CLI commands supported on AOS switches. When 
a script file is applied, each CLI command in the file is sent to the device via Telnet. 

Important Note: Before attempting to apply a script, OmniVista must know the user 
name and password for each device being configured. Use Auto-Login to specify the 
login information. 

Users are not required to create script files using a third-party text editor. OmniVista provides a text box 
where CLI commands can be manually entered from the Telnet application. During the Telnet Scripting 
steps, these commands are saved to a script file (which can be accessed for reference or future 
applications). In addition, a log file containing status and troubleshooting information is generated 
automatically. Follow the steps below to create a script. 

1. Select the Create Scripts tab is selected and then click the New button.  
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2. Enter a descriptive file name in the Enter Filename text field. For example, new_vlan_config1. (The 
file extension .script will be added automatically when the script file is saved.) 

3. Press the Tab key or select the Enter Commands text box. Enter the CLI commands to be applied to the 
switch via this script. Be sure that all commands entered are AOS-compatible CLI commands; also, enter 
only one CLI command per line. 

Important Note: Operational commands that automatically issue a confirmation prompt 
and require the user to type a response (like Y or N) are not supported in CLI script files. 
Examples include takeover, reload, fsck, etc. Do not attempt to include these command 
types in the script file. Instead, manually issue them via the standard CLI command line 
prompt. These operations can also be issued on a device-by-device basis via WebView or 
OmniVista. 

4. Verify that the syntax of all commands are correct before proceeding. When finished, click the Save 
button. 

When the Save button is clicked, the script entries are automatically saved to a .script file. This file can be 
especially helpful if you want to save a particular configuration for later use. By default, the file is saved in 
OmniVista's scripting_files directory on the server or local system. This directory's location may vary, 
depending on the OmniVista installation, but can generally be found at a path similar to the following: 

Alcatel OmniVista 2500\data\telnet\scripting_files 

Click on the Send Script tab to send the script to specific switches.  
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Importing Existing Script Files 

Although OmniVista allows users to manually create script files within the Telnet application, existing 
script files can also be imported. In other words, a file containing a set of CLI commands can be accessed 
from a server or local drive and then applied to one or more devices. This allows users to maintain a library 
of network configurations and then apply them to devices in their network as needed. 

Before importing a file to one or more devices, consider the following important guidelines: 

• Any script file being imported must be text-based (ASCII).  
• Although file extensions such as .txt and .ascii are supported, the file extension .script is 

recommended for browsing purposes.  
• All CLI commands contained in the file must be AOS-supported. Also, operational commands that 

automatically issue a confirmation prompt and require the user to type a response (like Y or N) are 
not supported in CLI script files. Examples include takeover, reload, fsck, etc. Do not attempt to 
include these command types in the script file. Instead, manually issue them via the standard CLI 
command line prompt. These operations can also be issued on a device-by-device basis via 
WebView or OmniVista.  

• CLI commands must also be entered into the text file one command per line.  
• Only one script file can be imported at a time.  

To import a script file, click the Import button at the bottom of the main Telnet window. The Import 
Scripting File dialog box displays. Use the dialog box's Look In pulldown menu to locate the file being 
imported. 

Note: If you are browsing for a file with an extension other than .script, be sure to select 
Files of Type -> All Files in the dialog box, as shown: 

 

Once the script file has been located, select the file in the dialog box window; the file name displays in the 
File Name text field. Click the Import button. 

22 



Using the OmniVista Telnet Application 

 

Important Note: The script import procedure is not complete at this point. You must 
complete the additional steps described below. 

To continue the script import procedure, click the Send Script tab in the main Telnet window. The script 
file selected from the Import Scripting File dialog box is displayed in the Filename column. 

Note: If the Filename column does not display, be sure the Send Script tab is selected 
and, if needed, click the Back button until the column is displayed. 

Select the script file in the Filename column and then click the Next button. 
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A list of discovered devices is displayed. From the list, select the device to which the file is being imported 
and then click the Next button. 

Note: Telnet Scripting's import file option supports multiple devices. If the script file is 
to be applied to more than one device, simply Control-click or Shift-click all applicable 
devices in the list before clicking Next. Remember, however, Auto-Login must first be 
configured for all devices to which a file is being imported. 

The CLI commands in the script file are displayed in the Scripts Content window. 

If the selected device is without a Telnet username/password, then a dialog box will pop up, to allow you to 
enter the Telnet user name and password for the device. Enter the Telnet user name and password, and then 
click the OK button to close the popup dialog box. 

 

Click the Send Script button in the Send Script tab. The script file is now imported and applied to the 
switch, and the status of the import operation is displayed. 

Tip: If the file is not successfully imported (i.e., Percent Done does not reach 100), check 
the status pane at the bottom of the main Telnet window for troubleshooting information. 
The most common error when trying to import a file is missing login information. This 
can be corrected by configuring Auto-Login for the device. 
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Reminder: Changes made to a device using a script file are applied only to the device's 
running memory (i.e., RAM). If the device reboots or goes down unexpectedly, any 
unsaved changes will be lost. To save changes to the device's Working directory, you 
must either use the OmniVista Topology application or type write memory at the Telnet 
session command prompt. To save changes using the Topology application, right-click 
the device from the main Topology window and select Save to Working from the popup 
menu. If multiple devices have been configured using the script file, be sure to save 
changes for each device. 

Editing Script Files 

To edit a script file, select the file from the Filename list, then click Edit. The Enter Scripts text box 
(which was previously grayed out) becomes active. The CLI commands contained in the selected script file 
can now be deleted, modified, or appended. When the changes are complete, click the Save button. 

Important Note: When the changes are saved, the previous contents of the script file are 
overwritten. To preserve the original contents of the file, be sure to make a backup copy 
before editing. 

Deleting Script Files 

To delete a script file, select the file from the Filename list, then click Delete. 

Note: When a file is deleted, it is permanently removed from the scripting_files 
directory. Once a script file is deleted, it cannot be recovered. 

Click Yes in the Warning dialog box. 

 

Deleting Multiple Script Files 

Multiple log files can be deleted at once. To delete multiple script files, simply Control-
click or Shift-click all applicable files in the list before clicking Delete. Remember, 
however, that once the files have been deleted, they cannot be recovered. 

Viewing Log Files 

The View Logs tab allows users, on a command-by-command basis, to view Telnet Scripting results. In 
other words, it displays whether the contents of a file were successfully applied to the device. A log file 
also provides a record of a particular configuration, as well as effective troubleshooting information, when 
applicable. 

Unless an error has occurred, the log file will closely resemble the script file (i.e., it will list only the CLI 
commands that were applied to the device). If an error has occurred, an error notification displays in the 
log, following the CLI command that triggered the error. For more information, see the example below: 
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As with the scripting files, log files are automatically stored on the server or local system. File locations 
may vary, depending on the OmniVista installation, but can generally be found at a path similar to the 
following: 

Alcatel OmniVista 2500\data\telnet\scripting_logs 

Note: By default, log files are placed in a directory indicating the IP address of the 
corresponding device. 

Deleting Log Files 

To delete a log file, select the file from the Filename list, then click Delete. 

Note: When a file is deleted, it is permanently removed from the scripting_logs 
directory. Once a log file is deleted, it cannot be recovered. 

Click Yes in the Warning dialog box. 
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Deleting Multiple Log Files 

Multiple log files can be deleted at once. To delete multiple log files, simply Control-click or Shift-click all 
applicable files in the list before clicking Delete. Remember, however, that once the files have been 
deleted, they cannot be recovered. 

Specifying SSH Session Preference 

SSH (Secure Shell) provides Telnet sessions with enhanced encryption and security. SSH may be 
mandatory for some device types. OmniVista uses SSH by default for those devices requiring SSH. 
However, for AOS and other devices where SSH is optional, standard Telnet is the default setting. To use 
SSH, the user must specify SSH either on a device-by-device basis, or on multiple devices. 

Specifying SSH on a Single Device 

To specify SSH encryption on a single device, right-click the device in the Telnet Navigation Tree and 
select Edit from the popup menu that displays. 

The Edit-Discovery-Manager-entry dialog box displays. Click the checkbox next to Prefer SSH. When 
this box is checked, future Telnet sessions for this device will use SSH. When finished, click the OK 
button. 

Specifying SSH on Multiple Devices 

As with Auto-Login, specifying SSH for multiple devices is done through OmniVista's Topology 
application. Topology allows users to select multiple devices from a list and, in one step, specify the SSH 
preference for future Telnet sessions. 

To set up SSH for multiple devices, start by opening the Topology application. (Topology can be accessed 
via the Task Bar by clicking the Configuration group button and then the Topology application button.) 

When Topology launches, a list of all discovered devices displays. Using Control-click or Shift-click, 
select the devices from the list. Right-click over any of the selected devices. A popup menu displays. Select 
Edit from the menu. 

The Edit Discovery Manager Entry dialog box displays. Click the checkbox next to Prefer SSH. Future 
Telnet sessions for the selected devices will use SSH. When finished, click the OK button.  
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Creating and Using Telnet Scripts 
A Telnet script file is a text-based file used to configure one or more devices through OmniVista's Telnet 
Scripting feature. Telnet scripting is especially useful in applying batch updates or common configurations 
across multiple devices. A script file must contain only CLI commands supported on AOS switches. When 
a script file is applied, each CLI command in the file is sent to the device via Telnet. 

Note: Before attempting to apply a script, OmniVista must know the user name and 
password for each device being configured. Use Auto-Login to specify the login 
information. 

Users are not required to create script files using a third-party text editor. OmniVista provides a text box 
where CLI commands can be manually entered from the Telnet application. During the Telnet Scripting 
steps, these commands are saved to a script file (which can be accessed for reference or future 
applications). 

Note: For comprehensive Telnet help, including establishing one or more sessions with a 
device, click here or select "Telnet Help" from the main menu bar at the top of the 
OmniVista window. 

Pre-Configured Script Files 

OmniVista includes pre-configured Telnet script files to automate some common, routine tasks. A brief 
description of these scripts is provided below. 
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add_snmp_users.script - Generic script for adding a user that can be easily modified for a specific user. 

clean_flash.script - Cleans the dump files from the Primary and Secondary (if applicable) CMM and 
returns the flash to normal. 

Ewebimageclean.script - Removes all the web image files from an OmniSwitch 8800 switch. Prior to an 
FPGA upgrade (AOS Release 5.1.6), the web image files must be removed due to flash size limitations. 
This script automates the removal process. 

Fwebimageclean.script - Removes all the web image files from an OmniSwitch 7700/7800 switch. Prior 
to an FPGA upgrade (AOS Release 5.1.6), the web image files must be removed due to flash size 
limitations. This script automates the removal process. 

no_Quarantined.script - Deletes a MAC group called "Quarantine". 

Quarantined.script - Creates a MAC group called "Quarantine". 

save_config_snapshot.script - Creates a snapshot of the certified and working directory. 

show_switch.script - Writes the switch information (System, Chassis, and Hardware information) to a log 
file, which can be viewed by clicking on the View Log Tab. 

Important Note: Use caution when using the Ewebimageclean and Fwebimageclean 
scripts. Use the Resource Manager application to perform a full backup on the switch 
prior to an upgrade. 

Creating New Script Files 

To create a script, click the New button. Enter a descriptive file name in the Enter Filename text field. For 
example, new_vlan_config1. (The file extension .script will be added automatically when the script file is 
saved.) 

Next, press the Tab key or select the Enter Scripts text box. Enter the CLI commands to be applied to the 
switch via this script. Be sure that all commands entered are AOS-compatible CLI commands; also, enter 
only one CLI command per line. 

Note: Operational commands that automatically issue a confirmation prompt and require 
the user to type a response (such as, Y or N) are not supported in CLI script files. 
Examples include takeover, reload, fsck, etc. Do not attempt to include these command 
types in the script file. Instead, manually issue them via the standard CLI command line 
prompt. These operations can also be issued on a device-by-device basis via WebView or 
OmniVista. 

Verify that the syntax of all the commands is correct before proceeding. When finished, click the Save 
button. 
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Template Scripts 

You can also create template scripts. A "template" script is a script that contains special non-CLI syntax 
and keywords that represent OmniVista built-in variables or user defined variables  This allows a single 
CLI script to be reused without making a separate script. The variables in the template must be prefixed 
with '$' to show they are user defined variables. Examples of user defined variables are passing a 
community string name, VLAN number, MAC address, etc.  

 

When the Save button is clicked, the script entries are automatically saved to a .script file. This file can be 
especially helpful if you want to save a particular configuration for later use. By default, the file is saved in 
OmniVista's scripting_files directory on the server or local system. This directory's location may vary, 
depending on the OmniVista installation, but can generally be found at a path similar to the following: 
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Alcatel OmniVista 2500\data\telnet\scripting_files 

Important Note: The Telnet Scripting procedure is not complete at this point. You must 
click on the Send Script tab in the main Telnet window and follow the remaining steps in 
order to send the script file to the device(s). 

Importing Existing Script Files 

Although OmniVista allows users to manually create script files within the Telnet application, existing 
script files can also be imported. In other words, a file containing a set of CLI commands can be accessed 
from a server or local drive and then applied to one or more devices. This allows users to maintain a library 
of network configurations and then apply them to devices in their network as needed. 

Before importing a file to one or more devices, consider the following important guidelines: 

• Any script file being imported must be text-based (ASCII).  
• Although file extensions such as .txt and .ascii are supported, the file extension .script is 

recommended.  
• All CLI commands contained in the file must be AOS-supported. Also, operational commands that 

automatically issue a confirmation prompt and require the user to type a response (such as, Y or 
N) are not supported in CLI script files. Examples include takeover, reload, fsck, etc.  

• CLI commands must also be entered into the text file one command per line.  
• Only one script file can be imported at a time.  

To import a script file, click the Import button at the bottom of the main Telnet window. The Import 
Scripting File dialog box displays. Use the dialog box's Look In pulldown menu to locate the file being 
imported. 

Note: If you are browsing for a file with an extension other than .script, be sure to select 
Files of Type -> All Files in the dialog box, as shown: 
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Once the script file has been located, select the file in the dialog box window; the file name displays in the 
File Name text field. Click the Import button. 

 

Note: The script import procedure is not complete at this point. You must click on the 
Send Script tab in the main Telnet window and follow the remaining steps in order to 
send the script file to the device(s). 

Editing Script Files 

To edit a script file, select the file from the Filename list, and then click Edit. The Enter Scripts text box 
(which was previously grayed out) becomes active. The CLI commands contained in the selected script file 
can now be deleted, modified, or appended. When the changes are complete, click the Save button. 

Note: When the changes are saved, the previous contents of the script file are 
overwritten. To preserve the original contents of the file, be sure to make a backup copy 
before editing. 

Deleting Script Files 

To delete a script file, select the file from the Filename list, and then click Delete. 

Note: When a file is deleted, it is permanently removed from the scripting_files 
directory. Once a script file is deleted, it cannot be recovered. 

Click Yes in the Warning dialog box: 
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Deleting Multiple Script Files 

Multiple log files can be deleted at once. To delete multiple script files, simply Control-click or Shift-click 
all applicable files in the list before clicking Delete. Remember, however, that once the files have been 
deleted, they cannot be recovered. 
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Sending Script Files 
You can send a script file to a single device or multiple devices in the network. To send a script file to a 
device or devices, select the script file in the Filename column of the Send Script tab, then click the Next 
button.  

Note: You can also schedule a script to run at a later time. Click here for instructions on 
 scheduling scripts.  

 

A list of discovered devices is displayed. Select the device(s) to which you want to send the script. Note 
that "Auto-Login" must first be configured for all devices to which a file is being sent. 
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After selecting the device(s), click the Next button. The Send Script Panel is displayed: 
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Click the Send Script button. If the selected device does not have a Telnet username/password, a dialog 
box will pop up to allow you to enter the Telnet username and password for the device. Enter the Telnet 
username and password, and then click the OK button.  

Note: The Telnet Scripting feature supports multiple devices. If the script file is to be applied to more than 
one device, simply Control-click or Shift-click all applicable devices in the list before clicking Next. 
Remember, however, Auto-Login must first be configured for all devices to which a file is being applied. 

If the selected device is without a Telnet username/password, then a dialog box will pop up, to allow you to 
enter the Telnet user name and password for the device. Enter the user name and password, and then click 
the OK button to close the pop-up dialog box. 
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Scheduling a Script  

OmniVista allows you to schedule scripts to run at a later time. You can schedule a script to run a single 
time, or schedule the script to run at regular intervals. To schedule a script to run at a later time, click the 
Schedule Script button at the bottom of the Send Script tab. The Schedule Script window appears.  

 

Enter the date and time for the script to run in the Start Time field. To run the script just once, leave the 
Time Interval field black and click the OK button. To run the script at regular intervals, enter a value in 
the Time Interval field, and select a time period from the drop-down menu to the right (e.g., Hours, Days, 
Weeks), then click the OK button.    
Note: If a time interval is not specified, there will not be any recurrence by default. To view, reschedule, or 
remove a scheduled job, use the Schedule application. Results from the running of a scheduled script are 
written to the Telnet Log.  

Tips for Sending Scripts 

If the file is not successfully applied ( "Percent Completed" does not reach 100), check the Status Pane at 
the bottom of the main Telnet window for troubleshooting information. The most common error when 
trying to apply a file is missing login information. This can be corrected by configuring Auto-Login for the 
device. Status information for each of the CLI commands applied can be viewed by clicking the View Logs 
tab in the main Telnet window.  
Important Note: Changes made to a device using a script file are applied only to the device's running 
memory (i.e., RAM). If the device reboots or goes down unexpectedly, any unsaved changes will be lost. 
To save changes to the device's Working directory, you must either use the OmniVista Topology 
application or type write memory at the Telnet session command prompt. To save changes using the 
Topology application, right-click the device from the main Topology window and select Save to Working 
from the pop-up menu. If multiple devices have been configured using the script file, be sure to save 
changes for each device.  
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Viewing Log Files 
The View Logs tab allows users, on a command-by-command basis, to view Telnet Scripting results. In 
other words, it displays whether the contents of a file were successfully applied to the device. A log file 
also provides a record of a particular configuration, as well as effective troubleshooting information, when 
applicable. 

Unless an error has occurred, the log file will closely resemble the script file (i.e., it will list only the CLI 
commands that were applied to the device). If an error occurs, an error notification is displayed in the log, 
following the CLI command that triggered the error. For more information, see the example below: 

 

As with the scripting files, log files are automatically stored on the server or local system. File locations 
may vary, depending on the OmniVista installation, but can generally be found at a path similar to the 
following: 

Alcatel OmniVista 2500\data\telnet\scripting_logs 

Note: By default, log files are placed in a directory indicating the IP address of the 
corresponding device. 
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Deleting Log Files 

To delete a log file, select the file from the Filename list, and then click Delete. 

Note: When a file is deleted, it is permanently removed from the scripting_logs 
directory. Once a log file is deleted, it cannot be recovered. 

Click Yes in the Warning dialog box. 

 

Deleting Multiple Log Files 

Multiple log files can be deleted at once. To delete multiple log files, simply Control-click or Shift-click all 
applicable files in the list before clicking Delete. However, remember that once the files have been deleted, 
they cannot be recovered. 

Exporting Log Files 

To export a log file, select the file from the Filename list, and then click Export. A dialog box will be 
displayed. This dialog box will help you export the selected log file to a directory of your choice. 
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